
Timbuktu Pro for Mac OS, version 7 At a Glance

Starting Timbuktu Pro

By default, the Timbuktu Pro Host is launched automatically when 
you start your Macintosh. To work with Timbuktu Pro or establish an 
outgoing connection, click the application icon (located by default 
on the menu bar in the upper-right corner of your screen) and 
choose Open Timbuktu Pro.

The Timbuktu Pro Host is started automatically whenever you start 
your Macintosh unless you have turned on the Only Accept Incoming 
Connections When Application is Open option on the General tab in 
the Preferences dialog box. If this option is enabled, Timbuktu Pro 
will not start automatically. To start Timbuktu Pro, open the 
Timbuktu Pro folder and double-click the Timbuktu Pro icon.

Selecting a Remote Computer

Before you can use any Timbuktu Pro service with a remote com-
puter, you must establish a connection with the computer. You’ll do 
this in the New Connection window. Click the File menu and choose 
New Connection.

The New Connection window is the starting point for all remote con-
nections. Choose a tab—Address Books, Dial Direct, TCP/IP, or 
TCP/IP Scanner— to start the connection procedure.

Note: Depending on your installation, not all tabs may be displayed. 
For example, the Dial Direct tab is not available in some versions.

You can establish a Timbuktu Pro connection to a remote computer 
by entering its IP address, domain name, or email address on the 
TCP/IP tab. You may also use the TCP/IP Scanner tab to search your 
network for the computer you want, or enter its phone number on 
the Dial Direct  tab to make a direct modem-to-modem connection. 
As long as you have been granted access as a Guest User, Ask for 
Permission User, or Registered User, you can connect to any com-
puter that is running Timbuktu Pro. 

Using Address Books
An address book is a collection of Timbuktu Pro addresses you can 
use to keep your favorite addresses organized. Once you have 
added an address to your address book, you don’t have to re-enter it 
each time you connect to that computer. Simply select it and choose 
a service from the Service menu or the Button Bar.

To add addresses to an address book, first make sure the desired 
address book is open. To open an address book, choose its name 
from the File menu.

1. In the New Connection window, select a computer on the TCP/IP 
Scanner tab, enter an address on the TCP/IP tab, or enter a 
phone number on the Dial Direct tab.

2. From the Service menu, choose Save in Address Book.



Using Timbuktu Pro Services

Using Send

The Send service lets you send messages, files, and 
folders to remote computers. 

1. In the New Connection window, select the remote 
computer.

2. From the Service menu, choose Send. Or click the 
Send service button. The Send window is displayed. 
(Note that you may need to ask for permission or log 
in as a Registered User before the window opens.)

3. To send a note, type a message in the Message 
panel. 

4. To include files with your message, click the Add 
button.
Note: You may also drag and drop files and folders 
from the desktop into the Enclosures area in the 
Send window.

5. In the Add Files or Folder dialog box, navigate to 
and select the files or folders you want to add, and 
click the Add  button. 

6. Click the Send  button in the Send window to send 
the FlashNote and files. 

Using Exchange

With Timbuktu Pro’s Exchange service, you can copy and 
move files and folders in both directions between your 
computer and another Timbuktu Pro computer.

1. In the New Connection window, select the remote 
computer.

2. From the Service menu, choose Exchange. Or click 
the Exchange  service button.
The Exchange window is displayed. (Note that you 
may need to ask for permission or log in as a Regis-
tered User before the window opens.)
The left panel lists the drives, folders, and files on 
your computer. The right panel lists the same infor-
mation for the remote computer.

3. Locate the desired files or folders and drag them 
from the source panel to the desired folder in the 
destination panel.

4. When you have finished exchanging files, close the 
Exchange window.



Using Control or Observe

You can use Timbuktu Pro to control or observe a remote com-
puter. The desktop of the remote computer is displayed in a win-
dow on your screen. When you control another computer, you can 
perform any of the tasks that you can perform locally, including 
opening applications and creating new files. When you observe 
another computer, you can watch its screen but you cannot control 
it. 

1. In the New Connection window, select the remote computer.
2. From the Service menu, choose Control or Observe. Or click 

the Control or Observe service button. Timbuktu Pro displays 
the remote computer’s desktop in a screen-sharing window. 
(Note that you may need to ask for permission or log in as a 
Registered User before the window opens.) With the Observe 
option, you will be able to observe the screen only; with the 
Control option, you can use your mouse and keyboard to 
operate the remote computer. Click on a screen-sharing win-
dow to make it the active window. To return to your own com-
puter, click outside the screen-sharing window.

3. To stop controlling or observing, close the screen-sharing 
window. 

Using Chat

The Chat service lets Timbuktu Pro users post messages to one 
another interactively. You may chat with more than one remote 
user simultaneously.

1. In the New Connection window, select the remote computer.
2. From the Service menu, choose Chat. Or click the Chat 

service button. The Chat window is displayed. (Note that you 
may need to ask for permission or log in as a Registered User 
before the window opens.)

3. Type your first message and press Return or click the Send  
button.

4. Your message is copied to the transcript panel in the upper 
part of the window and to the Chat window on the remote 
computer. Type more messages immediately or wait for a 
reply from the other user.

5. The reply is displayed below your message in the transcript 
panel. You can keep typing messages back and forth as long 
as you like.

6. When you’ve finished chatting, click the Disconnect button. 
When either party disconnects, the session is ended, and the 
message at the bottom of the window changes to 
Disconnected.

7. Click the Close button in the upper-right corner to close the 
chat window.



Using Notify

Timbuktu Pro’s Notify service lets you leave a request to be noti-
fied when another Timbuktu Pro computer becomes active. 

1. In the New Connection window, select the remote computer.
2. From the Service menu, choose Notify. Or click the Notify ser-

vice button. The Notify window is displayed. (Note that you 
may need to ask for permission or log in as a Registered 
User before the window opens.)
“Waiting for activity” appears near the top of the window. 
Below it are the following fields:

3. While you’re waiting, you can work on tasks in other win-
dows. You can minimize the Notify window, but don’t close 
it.

Timbuktu Pro will play an alert sound and bring the Notify win-
dow to the foreground when the remote user presses a key or 
moves the mouse.

Using Intercom

The Intercom service lets Timbuktu Pro users talk to each other 
through their computer’s audio hardware.

1. In the New Connection window, select the remote computer.
2. From the Service menu, choose Intercom. Or click the 

Intercom  service button. The Intercom window is displayed. 
(Note that you may need to ask for permission or log in as a 
Registered User before the window opens.)

3. When the Intercom window is displayed, you can begin 
speaking with the remote user.
Note: The Intercom window does not automatically stay on 
top of the screen when other application windows are run in 
the foreground.

4. When you’ve finished talking, click Close.

Using Invite

The Invite service allows you to invite other users to visit your 
computer. Once you have specified a user to receive your invita-
tion, select the service to allow and send the invitation to the re-
mote user. The recipient can use the service immediately or 
decline your invitation by closing the service window.

1. In the New Connection window, select the remote computer.
2. From the Service menu, choose Invite. Or click the Invite but-

ton on the Button Bar. The Invite window is displayed.
3. In the Invite window, specify the service you wish to invite 

the other user to access. Then click Invite.
4. The Invite window appears on the remote computer, display-

ing the service you invited the visitor to use. The invited visi-
tor may begin using the service or close the window to 
cancel it.



Using Profile

The Profile service allows you to generate a full system profile for the 
remote computer and save it as a text file on your Macintosh.

1. In the New Connection window, select the remote computer.
2. From the Service menu, choose Profile. Or click the Profile but-

ton on the Button Bar. The Profile window is displayed. (Note 
that you may need to ask for permission or log in as a Regis-
tered User before the window opens.)

3. Specify a file name and location for the system profile to be 
saved on your local computer. Then click Save.

4. The system profile is generated on the remote computer and 
saved as a text file in the location you specified. When the pro-
cess is complete, the Profile window indicates that the profile 
has been saved and displays the file name.

Click the Open button to open the saved system profile in your de-
fault text editor.

Setting Up Incoming Access

Visitors have access to your computer only after you’ve enabled one 
or more of the transports in the Incoming Access dialog box. You 
may also quickly enable and disable incoming access by selecting 
transports in the Connection menu. 

1. From the Setup menu, choose Incoming Access.
The Incoming Access dialog box appears.

2. Select or clear the checkboxes to enable or disable incoming 
connections using each transport.
Note that if you turn off a transport, you can still use that trans-
port to make outgoing connections. Turning off a transport dis-
ables only incoming connections.

3. Close the Incoming Access dialog box.

Other Timbuktu Pro users can now establish connections to your 
computer over the selected transports.

By default, Timbuktu Pro will not answer  Dial Direct calls into your 
computer even when you turn on the Dial Direct transport. You must 
also grant Dial Direct access to selected visitors in the Define Users 
dialog box.



Assigning User Access Privileges

The Define Users dialog box allows you to specify the services avail-
able to Guest Users and Ask for Permission Users. It also allows you 
to create and manage your Registered Users. To open the Define Us-
ers dialog box, click the Setup menu and choose Define Users.

When you grant a service to Guest Users, any Timbuktu Pro user may 
access that service on your computer without entering a password. To 
grant services to Guest Users, select Guest and click Edit. Assign the 
desired services to Guest Users by clicking them.

Granting services to Ask for Permission users makes it possible for 
visitors to request that service on a one-time basis. When the user re-
quests permission, you can choose whether or not to admit them. To 
grant services to Ask for Permission users, select Ask for Permission 
and click Edit. Assign the desired services to Ask for Permission Visi-
tors by clicking them.

Registered Users must supply a user name and password to access 
your computer. You can create as many Registered Users as you wish, 
and assign each user a specific set of access privileges. Registered 
Users can access their assigned services anytime Timbuktu Pro is 
running on your computer. To add a new Registered User, click the 
New button in the Define Users window. Then enter a name and 
password and select the services you wish to grant to that visitor.

Enabling the IP Locator

When you set up Timbuktu Pro, you may wish to enter your email ad-
dress on the IP Locator tab in the Preferences dialog box. When you 
specify an email address here, it is registered with the Internet Loca-
tor Server. Remote users can then connect to your computer by en-
tering your email address on the TCP/IP tab in the New Connection 
window. Users will not need to know your IP address to make the 
connection.

1. From the Setup menu, choose Preferences. 
2. On the IP Locator tab, enter your email address. 

Preparing for Dial Direct Connections

The Dial Direct tab in the Preferences dialog box lets you specify 
your modem’s properties and control the way in which your modem 
responds to incoming calls. In most cases, the default settings are 
suitable. Do not change the modem settings unless you are experi-
enced with modem configuration.

Before you can use the Dial Direct service, you’ll need to set up your 
calling locations. 

1. From the Setup menu, choose Calling Locations. In the Calling 
Locations dialog box, click New.

2. In the New Location dialog box, enter the relevant information 
in each field. See the Timbuktu Pro online Help for details.

3. Click Save to save your changes.



Documentation and Online Help

The Timbuktu Pro Getting Started Guide is a comprehensive manual that covers installing, setting up, and using Tim-
buktu Pro. Timbuktu Pro’s comprehensive online Help provides a variety of ways to answer your questions. It con-
tains step-by-step instructions for all common procedures, as well as troubleshooting hints, keyboard shortcuts, 
and a glossary. To open the online Help, click the Help menu and choose Timbuktu Help. If a Help button is available 
in a window or dialog box, click it to display the online Help topic associated with that window. 

Technical Support

If you require technical support, please browse Netopia’s Technical Notes and Frequently Asked Questions, avail-
able 24 hours a day on our Web site at http://www.netopia.com/support/. Most common questions and problems 
are addressed here. 

If you are unable to resolve your issue using our online technical support, please use our online email form to send 
us a message. The form is at http://www.netopia.com/support/contact_us.html.

You can contact Netopia Customer Service on the Web or by mail or fax:

Mail: Netopia Customer Service, 6001 Shellmound Street, Emeryville CA 94608 USA
Fax: (510) 420-7609
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